LAB 3 MANAGING DISKS AND FILE SYSTEMS
This lab contains the following exercises and activities:

· Exercise 3-1: Formatting a Partition

· Exercise 3-2: Converting FAT32 Partitions to NTFS

· Exercise 3-3: Converting a Basic Disk to a Dynamic Disk

· Exercise 3-4: Examining Drive Properties

· Exercise 3-5: Using NTFS Compression

· Exercise 3-6: Using EFS Encryption

· Exercise 3-7: Assigning Disk Quotas

· Lab Review Questions

· Lab Challenge 3-1: Using Disk Tools

SCENARIO

Currently, the workstations in the graphic design department at Contoso, Ltd., all have one partition and use basic disks. Backups of data are completed by backing up selected parts of the system partition.

To make backing up data simpler, and to make disaster recovery easier by separating data and operating system partitions, you need to create dynamic disks with NTFS simple volumes. There will be an operating system (OS) volume and a data volume on each computer. This will allow data backup to be performed by making backups of a particular drive and will make installing a new OS (if necessary in the event of a disaster) easier without disturbing data.
After completing this lab, you will be able to:

· Manage hard disks using the Computer Management console.

· Create and format partitions.

· Convert basic disks to dynamic disks.

· Use NTFS compression.

· Use Encrypting File System (EFS) encryption.

· Assign disk quotas.

· Use Disk Tools.

Estimated lesson time: 100 minutes

Before You Begin
This lab uses the variable xx to refer to your number so that your computer name is referred to as Computerxx and your student identity as Studentxx. You are asked to pair with another student in this lab. Your partner's number will be referred to as yy.

NOTE by default, Microsoft Windows XP hides certain files and folders. This lab asks you to access some of these files. If they are hidden, a message in the Windows Explorer pane in which you are trying to access them will read "These Files Are Hidden;' To show the files, in the task pane on the left, in the System Tasks section, select Show The Contents Of This Folder. The files and folders will appear. Once you have completed this task once, you will not have to do so again for this user account. Also, this lab uses the Internet to update Windows. You might receive security warnings while using Microsoft Internet Explorer. Answer affirmatively to these messages to allow the lab to continue.

Exercise 3-1: Formatting A Partition
Estimated completion time:15 minutes

To create a data partition, you need to format the unpartitioned space remaining on your hard drive. To allow backward compatibility to legacy disk management tools (which Contoso uses), you need to format this partition using the FAT32 file system.

1. Log on to Contoso with your student account. (The password is P@sswOrd.)

2. From the Start menu, select Control Panel.

3. In Control Panel, click Performance And Maintenance.

4. In the Or Pick A Control Panel Icon section, click Administrative Tools.

5. In the Administrative Tools window, right-click Computer Management and select Run As.

6. In the Run As dialog box, select The Following User.

7. In the User Name text box, ensure that Computerxx\Administrator (this should be the default that appears) is entered. In the Password text box, type P@sswOrd. Click OK.

TIP:  When performing administrative tasks, it is a good practice to log on to a computer with an ordinary user or domain user account, and then to use Run As to apply credentials with the appropriate permissions. This helps to limit the chances of a malicious program running with Administrator privileges and also limits the damage that somebody else could do if you were to neglect to log off.

8. In the Computer Management console, in the console tree, under Storage, select Disk Management.

9. In the graphical view pane, in Disk 0, select the unallocated disk space. A hatch pattern will appear on the graphical representation of the unallocated space, as shown in the following figure.
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Note: the C: partition does not have the same size as the partition you created.

10. From the Action menu, point to All Tasks, and then select New Partition.

11. In the New Partition Wizard, on the Welcome page, click Next.

12. On the Select Partition Type page, ensure that Primary Partition is selected, read the description provided. and then click Next.

Question 1:  How many primary partitions can a basic disk contain?
13. Click Next.
14. On the Specify Partition Size page, in the Partition Size In MB text box, type 6000. Click Next.

NOTE It is important that there be a small amount of space left over. When a basic disk is converted to a dynamic disk (which you will do later in the lab), 1 megabyte (MB) of empty space is required to create a database. Windows 2000 and Windows XP reserve 1 MB or one cylinder, whichever is greater, when creating partitions on a hard drive. Other 0S’s, however, might not reserve any room, making the conversion impossible without resizing the partitions to leave some empty space.

15. On the Assign Drive Letter Or Path page, select Do Not Assign A Drive Letter Or Drive Path and then click Next. (You are not instructed to select a drive path at this point only so that you can be shown how to assign a drive letter through the Disk Management interface later.)

16. On the Format Partition page, ensure that Format This Partition With The Following Settings is selected. In the File System drop-down list, select FAT32. In the Volume Label text box, type Data.

17. Select the Perform A Quick Format check box. Your settings should match those in the following figure. 
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18. Click Next.
19. On the Completing The New Partition Wizard page, review the sum​mary and then click Finish. After a few moments, in the graphical view pane, a representation of the new partition should appear and be labeled DATA. The new drive configuration should look like this:
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Note: the C: partition does not have the same size as the partition you created.

20. In the graphical view pane, right-click DATA and then select Change Drive Letter And Paths.

21. In the Change Drive Letter And Paths For DATA dialog box, click Add.

22. In the Add Drive Letter Or Path dialog box, ensure that Assign The Following Drive Letter is selected, and in the drop-down list, select L. Click OK.

23. Leave the Computer Management console as is for the next exercise.

Exercise 3-2: Converting FAT32 Partitions To NTFS

Estimated completion time: 10 minutes

Contoso has upgraded its disk utility software and no longer requires backward compatibility to FAT32. Therefore, all partitions that are FAT32 are to be converted to NTFS.

1. In the Computer Management console, in the graphical view pane, right-click the DATA (L:) partition and then select Open.

NOTE The Disk Management console may also be opened with the command diskmgmt.msc. From the Start menu, select Run, and type the command in the Open text box.

2. In the DATA (L:) window, from the File menu, point to New and then select Text Document.

3. Name the text document Data.txt.

4. Close the DATA (L:) window.

5. From the Start menu, point to All Programs, Accessories, right-click Command Prompt, and then select Run As.

6. In the Run As dialog box, enter your local administrator credentials (user ID and password) and then click OK.

7. At the command prompt, type convert L: /fs:ntfs and then press ENTER.
8. At the Enter Current Volume Label For Drive L: prompt, type Data and then press ENTER. The following figure shows an example of this command being executed.
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9. Close the command prompt window.

10. In the Computer Management console, in the graphical view pane, right-click the DATA (L) partition and then select Open.

Question 2: Did the data on the partition survive the conversion from FAT32 to NTFS?

11. Close all windows except the Computer Management console, which is used in the next exercise.
Exercise 3-3: Converting A Basic Disk To A Dynamic Disk
Estimated completion time: 25 minutes

Technical Support at Contoso has decided to convert basic disks on some computers used as file servers to dynamic disks to take advantage of their greater flexibility. This will allow drives to be mounted in shared folders, among other things, such as software-based RAID.

The computers where the drives need to be converted are not easily accessible, so you need to connect to them remotely to make the changes.

The following steps will convert the basic disk on your partner's computer to a dynamic disk.

NOTE The following exercise needs to be completed first on the odd-numbered computer in each student pair, and then on the even-numbered computer.

1. If the Computer Management console is not currently open, open it using your local Administrator credentials.

2. In the Computer Management console, in the console tree, right-click Computer Management (Local) and then select Connect To Another Computer.

3. In the Select Computer dialog box, ensure that Another Computer is selected and type Computeryy (this is the computer number of your partner) in the text box. Click OK.

4. In the Computer Management console, in the console tree, expand Storage and then select Disk Management.

5. In the Graphical view pane, right-click Disk 0 and then select Convert To Dynamic Disk.

6. In the Convert To Dynamic Disk dialog box, ensure that the Disk 0 check box is selected and then click OK.

7. In the Disks To Convert dialog box, shown in the following figure, click Convert.
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8. In the Disk Management message box, click Yes to indicate that you want to convert.

9. In the Convert Disk To Dynamic message box warning that file systems on the converted disks will be dismounted, click Yes to continue the Operation.

IMPORTANT When you click OK in the next step, your partner's computer will restart.

10. In the Confirm text box indicating that the computer needs to restart, click OK.

11. On the computer that just restarted you will see a message about having to restart again do so.

12. Once the computer has restarted again have your partner log on to Contoso with his student account. Upon logging on, the computer might want to restart again. If so, restart, and log on again the same way.

13. Once your partner's computer has restarted, on your computer, in the Computer Management console, from the Action menu, select Refresh.

14. In the Disk Management message box, click Yes to reconnect.

Question 3: In the graphical view pane, what word has changed in the Disk 0 graphical representation?

15. Close all open windows.

IMPORTANT: After completing this exercise once, switch the roles of the odd-numbered and even-numbered computers and complete it again.

Exercise 3-4: Examining Drive Properties
Estimated completion time: 5 minutes

A computer that is primarily used as a file server for critical data needs to be secured against data loss. To accomplish this, you need to disable write caching on its hard disk.

NOTE: Write caching delays writing data to the disk until the OS decides that it is necessary. In the meantime, changes to the disk are cached, or stored, in memory. This saves time by performing costly write instructions in batches. However, if the computer loses power or halts, any data in the cache will not be written to the disk and will be lost.

1. Open the Computer Management console with the local Administrator credentials, and access Disk Management.

2. In the graphical view pane, right-click Disk 0 and then select Properties.

3. In the Drive Properties dialog box, in the Policies tab, clear the Enable Write Caching On The Disk check box.

4. Click the Volumes tab and fill in the following table;
	Disk
	

	Type
	

	Status
	

	Partition Style
	

	Capacity
	

	Unallocated space
	

	Reserved space
	


Question4: How many volumes are on Drive 0 and what are their names?

5. Close all open windows.

Exercise 3-5: Using NTFS Compression
Estimated completion time:15 minutes

The graphic design department uses lots of image files, which are quite large. To save room, they had been saving images as .jpg files, but noticed degradation in the images when they were printed.

They have therefore decided to use Windows bitmap (.bmp) files to store images, which are uncompressed. You need to implement NTFS compression, to save space, on a folder in which they store the .bmp images.

Note:  NTFS compression is a type of compression known as nonlossy. Nonlossy compression is compression that does not lose data. In other words, nonlossy compressed data, when uncompressed, looks exactly like the original data. Lossy compression, however, loses data in the interest of compression. An example of lossy compression is .jpg compression. Images encoded in the JFEG File Interchange Format do not contain the same data as the original file when uncompressed, and the quality of the image is therefore reduced.

1. From the Start menu, select My Computer.

2. In the My Computer window, browse to C:\Documents And Settings\All Users\Shared Documents.

3. In the Shared Documents folder, from the File menu, point to New and select Folder.

4. Name the folder Brochure Images.

5. Right-click Brochure Images and then select Properties.

6. In the Brochure Images Properties dialog box, on the General tab, click Advanced.

7. In the Advanced Attributes dialog box, select the Compress Contents To Save Disk Space check box, as seen in the following figure. Click OK.

NOTE: Remember that it is not possible to select both the Compress Contents To Save Disk Space check box and the Encrypt Contents To Secure Data check box simultaneously. It is not possible to use NTFS compression to compress data encrypted using EFS, or vice versa.
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8. In the Brochure Images Properties dialog box, click OK. 
Question 6: What color is the font for the Brochure Images folder?

9. In the Shared Documents folder, right-click blank space, point to New, and then select Bitmap Image.

10. Name the image Picure1.bmp.

11. Right-click Picture1.bmp, and then select Edit.

12. In Microsoft Paint, from the Image menu, select Attributes.

13. In the Attributes dialog box, in the Width and Height text boxes, type 2048, as shown in the following example, and then click OK.
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14. From the File menu, select Save.

15. Close Microsoft Paint.

16. In the Shared Documents folder, right-click Picture1.bmp and then select Properties.

Question 7: How large is the Picture1.bmp file on the disk?

17. Close the Picture1.bmp Properties dialog box.

18. In the Shared Documents folder, move the Picture1.bmp file into the Brochure Images folder by dragging the file into the folder.

19. Open the Brochure Images folder.

20. In the Brochure Images folder, right-click Picture1.bmp and then select Properties.

Question 8: The image file has been moved into a folder using NTF5 compression. Why isn't the file any smaller?

21. Close the Picturel.bmp Properties dialog box.

22. Right-click Picture1.bmp, and then select Cut.

23. Click the Up icon in the standard buttons toolbar (a folder with a green arrow on it).

24. In the Shared Documents folder, from the Edit menu, select Paste.

25. Right-click Picture1.bmp, and then select Copy.

26. Open the Brochure Images folder.

27. From the Edit menu, select Paste.

28. Right-click Picture1.bmp, and then select Properties.

Question 9: What is the size on disk of the Picure1.bmp file now?

Question 10: Why did the file shrink, when it remained full size when it was moved?

29. Close the Picture1.bmp Properties dialog box.

30. Click the Up icon in the standard buttons toolbar to return to the Shared Documents folder for the next exercise.

Exercise 3-6: Using NTFS Encryption
Estimated completion time: 15 minutes

The graphic design team is working on a brochure for proprietary software that Contoso is going to use for adjusting insurance claims. The software is expected to give the company an edge over other companies, and management is very paranoid about keeping the new concepts secret. To help protect this data, you need to create an encrypted data store using EFS on the computers of all the members of the graphic design team who are assigned to the project.

1. In the Shared Documents folder, from the File menu, point to New and select Folder.

2. Name the folder Sensitive Data.

3. Right-click the Sensitive Data folder and then select Properties.

4. In the Sensitive Data Properties dialog box, on the General tab, click Advanced.

5. In the Advanced Attributes dialog box, select the Encrypt Contents To Secure Data check box. Click OK.

6. Click OK in the Sensitive Data Properties dialog box.

Question 11: What color is the font for the Sensitive Data folder?

7. In the Shared Documents folder from the file menu, point to New and then select Text Document.

8. Name the document Sensitive Text.txt.

9. Open the Sensitive Text.txt file.

10. In Notepad, type Encrypted Data.

11. From the File menu, select Exit. When asked if you want to save changes, click Yes.

12. In the Shared Documents folder, move the Sensitive Data.txt file to the Sensitive Data folder.

13. Open the Sensitive Data folder.

14. Open the Sensitive Text.txt text file.

Question 12: Can you read the Sensitive Text.txt file?

15. Close Notepad.

16. Minimize the Sensitive Data folder.

17. From the Start menu, select Run.

18. In the Run dialog box, in the Open text box, type mmc.

19. In the Console 1 console, from the File menu, select Add/Remove Snap-In.

20. In the Add/Remove Snap-In dialog box, click Add.

21. In the Add Standalone Snap-In dialog box, select Certificates and then click Add. Click Close.

22. In the Add/Remove Snap-In dialog box, click OK.

23. In the console tree, expand Certificates, Personal, and then select Certificates. An example from Computer26 is shown in the following figure.
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24. In the Details pane, on the right-hand side, right-click the certificate and then select Delete.

25. In the Certificates message box, click Yes to delete the certificate.

26. Close the Console 1 console, and click No when asked if you want to save changes.

27. Log off and log back on to Contoso with your Student credentials.

28. Open the Sensitive Data folder (C:\Documents And Settings\All Users\Documents\Sensitive Data).

29. In the Sensitive Data folder, open Sensitive Text.txt
Question 13: What occurs when you try to open the Sensitive Text.txt file and why?

Exercise 3-7: Assigning Disk Quotas
Estimated completion time: 10 minutes

A multiuser workstation with user data stored on a local data drive is in danger of running out of storage space. Some of the users are downloading images from the Internet, which take a lot of space and do not have any purpose besides entertainment.

First, you want all new users of the system to be limited by quotas. New users should be subject to a disk quota of 500 MB. They should be warned when they have used more than 400 MB of space. You also want a log of users who exceed the warning level so that you can ask them what they are saving that is taking up so much space.

Also, you need to give the same quota to the existing local user Computerxx\ Studentxx.

1. Log off and log on with your local Administrator account. (The password is P@sswOrd.)

2. From the Start menu, select My Computer.

3. In the My Computer window, right-click DATA (L:) and then select Properties.

4. In the DATA (L:) Properties dialog box, in the Quota tab, select the Enable Quota Management check box.

5. Select Limit Disk Space To. In the corresponding text box, type 500, and in the drop-down list, select MB.

6. In the Set Warning Level To check box, type 400, and in the drop-down list, select MB.

7. Select the Log Event When A User Exceeds Their Warning Level check box. The following figure shows the correct settings.
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8. Click Quota Entries

9. In the Quota Entries For DATA (L:) window, from the Quota menu, select New Quota Entry
10.  In the Select Users dialog box, in the Enter The Object Names To Select (Examples) text box, type Computerxx\Studentxx and then click OK.

11. In the Add New Quota Entry dialog box, select Limit Disk Space To, and in the corresponding text box, type 500. Select MB in the drop-down list.

12. In the Set Warning Level to text box, type 400 and select MB in the drop-down list. You Quota tab should look like the one below. Click OK.
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13. Close the Quota Entries For DATA (L:) window.

14. Click OK in the DATA (L:) Properties dialog box.

15. In the Disk Quota message box, 
Question14: What does the message say in the Disk Quota message Box?

16. Click OK to enable the quota system.

17. Close all open windows.

Lab Review Questions
Estimated completion time: 15 minutes

1. What formatting file system options does Windows XP offer for hard drives using basic disks? 
2. When you converted the disk on your partner's computer to a dynamic disk, what type of volumes were created from the existing primary partitions?

3. Once you instruct Windows to convert a basic disk to a dynamic disk, you are warned that you will no longer be able to do what on any volumes on the converted disk?

4. What happens when you move an unencrypted and uncompressed file into an EFS encrypted folder or to an NTFS compressed folder?

5. What happens when you lose or remove a certificate issued for EFS?

6. When specifying disk quotas, for which two events can you enable logging?

Lab Challenge 3-1: Using Disk Tools

Estimated completion time: 25 minutes

You are working at the corporate help desk at Contoso, supporting users by phone. You have a user that complains that it seems to take longer to load large Microsoft Excel files than it used to on his computer. He also reports that he received an error while trying to load an Excel file the other day, but when he rebooted, it loaded fine.

He has plenty of empty space on his hard drive. You ask him if he has ever defragmented his hard drive, and he says that he has not. You have him print a report of the fragmentation status of his hard drive, and this is what it says:
Volume size 

= 49.34 GB

Cluster size 

= 4 KB

Used space 

= 16.64 GB

Free space 

= 32.71 GB

Percent free space 

= 66 %

Volume fragmentation

Total fragmentation 

= 46 %

File fragmentation 

= 92 %

Free space fragmentation 
= 0 %

File fragmentation

Total files 


= 8,222

Average file size 

= 3 MB

Total fragmented files 
= 2,208

Total excess fragments 
= 20,280

Average fragments per file 
= 3.46

Pagefile fragmentation

Pagefile size 

= 0 bytes

Total fragments 

= 0

Folder fragmentation

Total folders 

= 756

Fragmented folders 

= 28

Excess folder fragments 
= 222

Master File Table (MFT) fragmentation

Total MFT size 

= 22 MB

MFT record count

 = 9,005

Percent MFT in use 

= 39 %

Total MFT fragments 

= 3
Fragments File Size Most fragmented files

848 

83 MB 

\User Data\Owen\Documents\Work\als-272\

year_end_data.xls

251 

50 MB 

\User Data\Owen\Documents\War of the Species

Project\Rhino Models\Deer\tutorial\Financial_projections.xls

134 

536 KB \

System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10

100 

6 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0006069.cpl

100 

6 MB \

System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0004549.cpl

100 

6 MB \

System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008065.cpl

86 

6 MB \

User Data\Owen\Documents\Work\als-272\

Pages Reviews\8\ch08da_p1.pdf

86 

5 MB \

User Data\Owen\Documents\Work\als-272\

Pages Reviews\2\ch02da_p1.pdf

83 

164 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0006180.msi

83 

164 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008486.msi

83 

164 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008176.msi

75 

5 MB 

\System Volume Information\_restore

{63100537-12E8-49FB-99DE-1483BB9C654D}\RP243\A0021414.exe

69 

35 MB 

\User Data\Owen\Documents\War of the Species

Project\New Folder (3)\dragon 002.3dm

68 

4 MB 

\User Data\Owen\Documents\Work\als-272\

Pages Reviews\4\ch04da_p1.pdf

60 

4 MB

\User Data\Owen\Documents\Work\als-296\

grouppolwp.doc

60 

23 MB 

\User Data\Owen\Documents\War of the Species

Project\Rhino Models\elephant\Elephant 3-xxx.3dm

59 

4 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0006167.dll

59 

4 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008473.dll

59 

4 MB 

\User Data\Owen\Documents\Work\als-272\

Pages Reviews\6\ch06da_p1.pdf

59 

4 MB 

\System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008163.dll

58 4 MB \System Volume Information\_restore

{63100537-12E8-49FB-99DE-1483BB9C654D}\RP243\A0021415.dll

55 3 MB \System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0006078.exe

55 3 MB \System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0004558.exe

55 3 MB \System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0008074.exe

54 3 MB \User Data\Owen\Documents\Work\als-272\

Pages Reviews\10\ch10da_p1.pdf

51 3 MB \System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP5\A0005236.dll

51 3 MB \System Volume Information\_restore

{A1768CD3-D50E-4D89-BF76-492D52D2A6F2}\RP10\A0006948.dll

51 3 MB \User Data\Owen\Documents\Work\als-296\

Labs\11\WinXP\Display\nv4_disp.dll

50 3 MB \User Data\Owen\Documents\Work\als-272\

Pages Reviews\5\ch05da_p1.pdf

49 3 MB \User Data\Owen\Documents\Work\als-296\

Labs\11\WinXP\AudioUtl\SSWAV06.WAV

Question 1: Excel files use the .xls extension. Of how many fragments are the two .xls files in the Most Fragmented Files list composed?

Question 2: What is the fragmentation percentage of all files on the volume?

After looking at the fragmentation status of his hard drive, you decide to run Chdsk first and then perform a defragmentation of his hard drive. To complete this lab challenge, you must do the following:
1. Run Chdsk on drive L:.

2. Output fragmentation information on drive L to a file on your desktop, and view the information.

3. Defragment drive D.

After completing the defragmentation open the file you created in step 2 on your desktop (the file name should be VoluemL.txt) and fill in the chart below:

	Volume size
	

	Used /space
	

	Free Space
	

	Percentage Free Space
	

	Total Files
	

	Average file size
	

	Total MFT size
	

	MFT record count
	

	Percent MFT use
	

	Total MFT fragments
	


